
2-1 
 

Guidance on Using Scanning Software: Part 2. VueScan 
Version of 12/22/2013 

 

VueScan can be used with virtually any scanner and multiple scanners can be used with the 

license for one copy of the program. The same workflow and controls can be used with different 

models and brands of scanners. VueScan is available in a standard edition (about $40) and a 

professional edition (about $80). The primary difference for historical scanning is that the 

professional edition handles more complete color management and offers free upgrades 

indefinitely. The professional edition also has the option to output an image file with the raw 

scan data.  

VueScan offers great control of clipping when making tone and color adjustments but 

assumes the final refinement of tone and color adjustments will be done with image-editing 

software. The information on VueScan in this guidance was obtained from the manual (Hamrick 

Software, 2013) and from communication with Ed Hamrick, the developer of VueScan. 

2.1 Workspace Layout 

As shown in Figure 2.1 the VueScan workspace is organized as a display of the image being 

processed and a series of six tabs that bring up lists of fields that are the settings for scanning. 

These lists are used to control scanning. The lists include settings that will be constant across 

scans and settings that will typically be adjusted for each individual scan. The actual items that 

appear in the lists depend on the settings that are selected. For example, when the scan 

resolution is set to Custom an additional field for entering the scan resolution appears. Another 

example is that the options for different types of negative film appear only after the item being 

scanned has been specified as negative film.  
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Figure 2.1. The main workspace for VueScan. The tabs and fields on the left are the scanning controls.  
The output histogram is shown in the lower left.   

 

 

 

In VueScan the area that is selected for inclusion in the final scan is called the crop area. An 

initial low-resolution preview scan is made and the crop area set from that. After the high-

resolution scan is made, the display area tab for Scan displays only the cropped area. The display 

can be switched to the initial preview display by clicking the Preview tab. 

One key point for using VueScan efficiently is to save sets of settings for reuse. A good 

starting point is to make a set of settings for each combination of scanner, type of source (paper, 

negative, slide), and color mode (color or grayscale). The settings are saved and loaded from the 

dropdown menu File> Save Options and File> Load Options. Shortcuts using the function keys 

are shown on the dropdown menu. The settings for all six tabs are saved and/or loaded. For 

example, one set of saved settings could be named V600_paper_gray, which has the default 

settings for using an Epson V600 scanner for scanning a paper black and white photograph. 

V600_negative_color would be the corresponding settings for scanning color negatives. The 

saved options are loaded and then the settings for cropping, resolution, and color adjustments 

are modified for the specific item being scanned. Settings can be saved for any condition that will 

be reused.  
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Another key to using VueScan efficiently is to recognize that most settings can be changed 

without needing to redo the high-resolution scan. The settings under the Color, Filter, and 

Output tabs can be changed after the high-resolution scan has been made (with certain 

qualifications noted later for infrared dust and scratch correction and for raw output). Those 

who have worked with other scanning software often tend to unnecessarily and inefficiently redo 

the high-resolution scan after making revisions to tone and color settings. With VueScan, 

rescanning is usually needed only if a setting under the Input or Crop tab is changed. Among the 

benefits of this strategy is that the item can be removed from the scanner and held up next to the 

monitor while tone and color adjustments are made. 

2.2 Standard Option Settings 

This section describes the settings that are usually relevant when saving a set of settings. The 

settings are identified here by the tab and item label. For example, Color> Color Balance: 

indicates the item or field labeled Color Balance under the Color tab (as shown in Figure 2.1). All 

the setting options for a tab may not be displayed. If the More button is shown on the bottom of 

the workspace, clicking it will display all the setting options. 

Input Tab 

The Input tab sets the type and resolution of the scan and certain other properties. 

Input> Task: is set to “Scan to file” for basic archival scanning. 

Input> Source: is used to select the scanner that is being used. The scanner must be turned on. 

Input> Mode: is set to “Flatbed” for reflective scanning of paper items and to “Transparency” for 

slides or negative. 

Input> Media: is set to the type of item being scanned. The options depend on whether the mode 

is flatbed or transparency. If the media is set to a negative or slide, additional options for 

different brands and types of negatives or slides appear under the Color tab. The only Media 

setting that is not obvious is “Image” for transparency. This option is intended to capture the 

slide or negative as it appears without any correction for the brand or type of film, including 

without converting negatives to positive images. This option would normally not be used for 

historical scanning. 

Input> Media size: should be set to “Maximum” if items larger than 8.5 x 11 inches are scanned. 

The default setting of “Auto” scans at either 8.5 x 11 inches or A4 size depending on the time 

zone the computer is in. The scanning bed for most flat bed scanners is greater than 8.5 x 11 
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inches and the “Maximum” setting is needed to utilize the full scanning bed. Another option 

that could be efficient is to save a set of settings for different sized items. 

Input> Quality: may or may not appear depending on other settings. It can be set to “Archive” 

but the key parameters that this affects will be controlled without using this setting. 

Input> Bits per pixel: is the bit depth for the raw scan and processing within VueScan. The bit 

depth for the output file is set under the Output tab. Bits per pixel can be set to “Auto” for a 

transparency (slide or negative) because the maximum bit depth of the scanner is used for a 

transparency. For a flatbed or paper scan, it should be set to “16 bit Gray” for a grayscale 

item or “48 bit RGB” for a color item. The Auto setting gives 8 bits per channel for reflective 

scans rather than the maximum bit depth of the scanner. Note that the option for “64 bit 

RGBI” is used when infrared scratch and dust correction is being applied, which is usually 

only for slides or negatives. 

Input> Make gray from: is an option for scanning grayscale and can be left as “Auto.” As noted in 

Chapter 2, if finessing of the conversion to grayscale is needed, then the master image should 

typically be kept as color. 

Input> Preview resolution: sets the resolution of the preview image. The Auto values often are 

not sufficient to accurately set cropping, particularly when the original item is small. I set this 

to 200 or 300 dpi for paper originals and 400 dpi for film. It may be necessary to use the 

Custom option, which brings up a field to set the resolution. As noted in a later section, for 

scanning documents that are based on ppi rather than total pixels on the longest side, the 

preview resolution can be set to the same resolution as the scan resolution below and a 

separate high-resolution scan is not needed. 

Input> Scan resolution: sets the resolution for the high-resolution scan. A default value is 

specified for saved settings but this field will be set for the specific item as described in the 

workflow and adjustments section below.  

Input> Auto skew: should be left blank for archival scanning. This sometimes rotates the image 

slightly. The software rotation slightly softens the image. 

Input> Auto save: determines whether the output image is written to a file immediately after the 

scan is completed. I set this to “None” because I make color adjustments after the scan is 

completed and the attempt to automatically write an output file is a nuisance.  

Crop Tab 

The Crop tab has settings for the cropping or selection of what is included in the final scan. 

The default value of Auto automatically sets a useful starting point for selecting the crop size in 

most cases. The final cropping is done as described in the workflow and adjustments section 
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below. This tab also determines how much of the scanning bed is included in the preview image. 

This setting will normally also be left with the default Auto value. However, reducing the 

preview area could reduce scanning times if many scans are done with a consistently sized small 

original. Numeric values need to be entered for defining the preview area. An easy way to do 

that is to set the cropped area to the desired preview area and copy the numbers from the crop 

fields to the preview fields. Then set the crop size back to Auto. 

Filter Tab 

The Filter tab has settings for certain color adjustments and for infrared dust and scratch 

correction if the scanner has that option. These will normally be turned off by default and used 

as described in the workflow and adjustments section below. 

 

Color Tab 

The Color tab is where the primary adjustments for tone and color are made. Most of these 

settings will be adjusted as described in the workflow and adjustments section below. Values that 

are a good starting point can be set as useful defaults. The Color tab also has the color 

management settings that are described in a separate section below. 

Color> Color balance: sets the basic tone and color adjustments. Useful saved settings are “White 

balance” which adjusts overall tone and individual colors or “Neutral” which adjusts overall 

tone without adjusting individual colors.  

Color> Black point: determines where the black point for the grayscale histogram is set. The 

VueScan default value of 0% is appropriate for historical scanning. 

Color> White point: determines where the white point for the grayscale histogram is set. For 

historical scanning a saved value of 0% is preferable to the VueScan default of 1%. 

Color> Vendor:, brand:, and type: set the brand and type of film. These fields are displayed if the 

media type is transparency (negative or slide). For historical black and white film the brand 

and type are often not known. “KODAK,” “TMAX-100,” and “D-76 CI=.40” are useful saved 

values as a starting point.  

Color> Output color space: sets the working color space for the output file. Saved values can be 

set to “sRGB” or “Adobe RGB” for color and “Gray” for grayscale. The “Gray” output color 

space is Gray Gamma 2.2.  

Color> Pixel colors: is a checkbox that determines whether pixels that are clipped or out of gamut 

are displayed with special colors. Checking this box is very useful because it allows 
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verification that any pixels that are clipped do not include significant content. These specially 

colored pixels are displayed in VueScan but are not displayed in the output file.  

Color> Clipped black color: sets the color to display pixels that are set to pure black even though 

they are not pure black pixels in the original image. The default color is blue but I change it 

to yellow to be more visible in dark areas. 

Color> Clipped white color: sets the color to display pixels that are set to pure white even though 

they are not pure white pixels in the original image. The default color is green but blue is 

more visible. 

Color> Out of gamut color: sets the color to display pixels that are out of gamut for the assigned 

working color space. This is also useful. The default is cyan but I change it to red because 

cyan or light blue is near the colors that can be in gamut for Adobe RGB but out of gamut for 

sRG 

Color> Infrared defect color: sets the color for displaying dust and scratches that have been 

identified with infrared dust and scratch correction. The default is red but I switch it to 

magenta so red can be used for out of gamut colors as indicated above.  

Output Tab 

The Output tab has settings for the output file.  

Output> Default folder: determines where the output file is written. My usual workflow is to 

write all new scanned images to one folder and then move them to the appropriate project 

folder after the image has been checked. 

Output> Printed size: is set to “Scan size” for historical archives. 

Output> Magnification (%): is set to 100 for historical archives. 

Output> Auto file name: is a checkbox that is cleared to have a dialog box come up for each 

image so the user can assign the file name.  

Output> TIFF file: is a checkbox that is normally checked for archival scanning to produce an 

output file in TIFF format. 

Output> TIFF file name: can be set to a default name but this will be finally set for an individual 

image. 

Output> TIFF size reduction: is set to 1 for archival scanning. Any other value causes pixels to be 

combined to reduce the pixels in the output image. 

Output> TIFF multi page: is a checkbox that should be cleared for archival scanning. Multi page 

TIFF files are not widely supported by other software. 

Output> TIFF file type: sets the color and bit depth for the output file. As discussed in chapter 2, 

the usual values for archival scanning will be “8 bit Gray” or “24 bit RGB” for 8 bits per 
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channel output and “16 bit Gray” or “48 bit RGB” for 16 bits per channel. This field has an 

option to include the infrared data if infrared dust and scratch correction was done; however, 

that is not a standard practice and is not appropriate for the main master image. It might be 

appropriate for a supplemental image with the recognition that it may not be accessible 

decades in the future.  

Output> TIFF compression: should be off for most archival scanning because it makes the output 

file more susceptible to problems. 

Output> TIFF DNG format: is a checkbox that should be cleared for archival scanning because it 

makes the output file not a standard TIFF format. 

Output> TIFF profile: is a checkbox that makes the output file have an embedded profile for the 

working color space. This should usually be checked, and is very important if the Adobe RGB 

color space is being used. 

Output> JPEG file: is a checkbox that is checked if an output file in JPEG format is wanted. 

VueScan can make both TIFF and JPEG files simultaneously. As described in Chapter 2, TIFF 

if the preferred output format for archival scanning but high quality JPEG may be used in 

certain circumstances.  

Output> JPEG file name: can be set to a default name but this will finally be set for an individual 

image. 

Output> JPEG size reduction: is set to 1 for archival scanning. Any other value causes pixels to be 

combined to reduce the pixels in the output image. 

Output> JPEG quality: determines the amount of compression and degradation of the JPEG file. 

Values of 90 or above are appropriate for archival scanning of photographs. Lower values 

may sometimes be useful for scanning documents without fine detail. 

Output> JPEG black/white: is a checkbox that can be checked to reduce the output file size for 

grayscale images. 

Output> JPEG profile: is a checkbox that makes the output file have an embedded profile for the 

working color space. This should usually be checked, and is very important if the Adobe RGB 

color space is being used. 

Prefs Tab 

The Prefs tab has general options for the operation of VueScan. Most can be left to the 

VueScan default values, but a couple may be appropriate to change.  

Prefs> External viewer: is a checkbox that will cause an image to be opened in a browser or other 

specified program after an image file has been saved. This can be useful if output images are 

always checked by viewing or will be modified with an image editor. However, this can also 
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be a nuisance if the image is not checked or modified. Clearing the checkbox will prevent the 

image from being automatically opened after saving. 

Prefs> Viewer: sets what program opens the image if the checkbox above is checked. “Default” 

opens the image with the default program set by the Windows operating system. 

Alternatively, a path to another program file can be specified. This option only appears if the 

checkbox for external viewer is checked. 

Prefs> Graph type: can be set to “Image” to display the output histogram of the image after the 

tone and color adjustments have been made. As described in the workflow and adjustments 

section below, this can be easily toggled on and off or changed to another type of graphical 

display. 

2.3 Workflow and Adjustments 

A good basic workflow for creating archival images with VueScan is: 

1. Load the set of saved settings that are appropriate for the type of source item. 

2. Create the preview image and select the area for scanning. 

3. Set the resolution from the preview image. 

4. Turn on infrared dust and scratch correction if it may be applied. 

5. Create the high-resolution scanned image. 

6. Adjust infrared dust and scratch correction and/or grain reduction if they are being used. 

7. Adjust tone and color. 

8. Set the output file name and save the image. 

Using the high-resolution scanned image for adjustments to tone and color has several 

advantages over using the preview image. The item can be removed from the scanner and held 

up next to the monitor for comparison while tone and color adjustments are made. The high-

resolution scanned image is automatically displayed at full size for the cropped area while the 

preview image is often much smaller. Also, the scanned image has higher resolution and more 

accurate display of histograms than the preview image.  

If the resolution of the final scan is the same or lower than the preview scan, the final image 

will be made from the preview scan without rescanning the source item. This can be used 

advantageously to save much time when scanning documents. However, the fact that the 

preview image will be saved when an image is saved prior to performing a high-resolution scan 

also allows unnoticed mistaken results if the high-resolution scan is unintentionally skipped 

when different resolutions are used for the preview and final scans. 
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Load the Set of Saved Settings that are Appropriate for the Type of Source Item 

A set of saved settings is selected and loaded by tapping F10 or with the main dropdown 

menu File> Load options.  

Create the Preview Image and Select the Area for Scanning 

The preview image is created by clicking the Preview button in the lower left. If needed the 

image can be rotated using the Input> Rotation: setting. A dotted line in the preview image 

shows the area that is selected for the final scan. The area outside the dotted line is cropped or 

removed. If the dotted line is not shown, it can be created by clicking and dragging the mouse 

pointer. The selected area can be moved by putting the mouse pointer in the middle of the area. 

The mouse pointer converts to a small hand that can be clicked and dragged to move the 

selected area. The edges can also be clicked and dragged to increase or decrease the size of the 

selected area.  

When scanning documents the preview resolution can be set to the final resolution that is 

wanted for the output file. Cropping and color adjustments can be applied to the preview image 

and the image saved without performing a separate high-resolution scan. The output results are 

the same as if a high-resolution scan were done with the same resolution settings. Using only the 

preview scan can save significant time when many pages are being scanned. The output cropping 

also can be set to different areas and color adjustments changed without redoing the preview 

scan—which allows multiple pages or items to be scanned, processed, and saved with one 

preview scan. This is highly efficient compared to the usual two-step process of making separate 

preview and high-resolution scans for each page or item. 

As noted earlier, the setting for Input> Media size: may need to be set to “Maximum” if the 

full scanning bed is to be used with items larger than 8.5 x 11 inches. 

Set the Resolution from the Preview Image 

The resolution of the final scan is set with Input> Scan resolution:. The hardware resolutions 

for the scanner are listed in a pick-list and the Custom option can be selected to bring up a field 

to enter a specific resolution. The overall dimension of the output image in pixels and inches and 

the output file size are displayed underneath the display image on the right. Although the 

VueScan manual recommends that custom resolutions be handled in Photoshop rather than with 

VueScan, my experience has been that the images with custom resolutions in VueScan are not 
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noticeably lower quality than the custom resolutions with Photoshop. Very slight differences can 

be seen at maximum enlargements.  

Turn on Infrared Dust and Scratch Correction if It may be Applied 

As described in Chapter 2, infrared dust and scratch correction can be very useful for color 

negatives and slides but is not applicable for most black and white film. The option 

Filter>Infrared clean: will be displayed if the scanner has infrared dust and scratch corrections. 

The possible settings are “None,” “Light,” “Medium,” and “Heavy.”  

The default processing of infrared dust and scratch correction appears to be different for 

different scanners. For my Nikon LS5000 ED scanner infrared cleaning data is apparently 

collected by default even if the setting is “None.” On the other hand, for my Epson V750 scanner 

infrared cleaning data is not collected unless the setting is specifically set to Light, Medium or 

Heavy when the high-resolution scan is made. For these cases, the most efficient process is to 

turn on infrared cleaning before the high-resolution scan. After the infrared data has been 

collected, the setting can be changed to a different level or to “None” without requiring another 

high-resolution scan. 

Create the High-Resolution Scanned Image 

After cropping and resolution have been set, the Scan button on the lower left is clicked to 

create the high-resolution scanned image. The high-resolution image will be display with 

cropping applied. The tabs for Preview and Scan determine whether the preview or scanned 

image is displayed in VueScan.  

If the preview scan was made with the same resolution as specified for the high-resolution 

scan, the preview scan will be used for the high-resolution scan without rescanning the item. 

(However, rescanning may be done if a custom resolution setting is used, even if the resolutions 

are the same.) As noted above, the step of making a separate high-resolution scan can be skipped 

in these cases, which can be very efficient for scanning documents. 

Adjust Infrared Dust and Scratch Correction and/or Grain Reduction if They Are Being 

Used 

Once the infrared data has been collected, the settings for Filter>Infrared clean: can be 

changed and the results will appear on the image display. It may take a few seconds to refresh 
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the display, but rescanning is not required. Infrared cleaning can be turned off at this point by 

setting the field to “None” without rescanning. The spots that the infrared process detects as 

defects can be displayed with the option Color> Infrared defect color: as described earlier. 

Grain reduction is valuable for certain scanners and types of original items. The option 

Filter> Grain Reduction: has possible settings “None,” “Light,” “Medium,” and “Heavy.” All of 

these settings are mild compared to grain reduction with other image-processing software. 

Unlike infrared cleaning, these settings can be initially applied after the high-resolution scan has 

been made. The effects are shown on the image display but may not be noticeable without 

significant enlargement and a high-resolution, sharp scanner. Special grain reduction software 

for image editing as described in Chapter 5 is normally more effective and preferable when 

available. 

Adjust Tone and Color 

As noted in the Introduction to this scanning guidance, adjustments to tone and color are 

described for three different conditions: (1) the scan is not adjusted for tone and color because 

those adjustments are made later with image-editing software, (2) the scan is adjusted for fading 

and exposure, and (3) the scan is adjusted for a reference target that is included to represent the 

current condition of the item. First, the settings for handling negatives are described. 

Options for Negatives 

Color> Vendor:, brand:, and type: set the brand and type of film. These fields are displayed if the 

media type is transparency (negative or slide). These settings significantly affect the tone and 

color of the image. For historical images the brand and type of film are often not known. For 

historical black and white film “KODAK,” “TMAX-100,” and “D-76 CI=.40” are useful starting 

values. The effect of different types of film can be explored until an optimal setting is found. 

The film brand and type would normally be set first even though they are not at the top of 

the list of color settings. 

Condition 1. Scan Not Adjusted for Tone or Color 

Two options can be used to obtain output files without tone and color adjustments. Infrared 

dust and scratch correction can be applied with both options, but careful handling of settings is 

needed for the raw output option. 

 
Converted Output. VueScan can apply the scanner color profile and film settings and 

convert the image to a working color space but not do any other adjustments to tone or color. 

http://archivehistory.jeksite.com/chapters/scan_part1.htm�
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This option is available in both the standard and professional versions of VueScan. When Color> 

Color balance: is set to None, the output image has the scanner color profile and film settings 

applied and is converted to the working color space. The settings for black and white points are 

not modified and are not presented as options for modification. The curves and brightness 

adjustments can be modified but should be left to the default values when adjustments will be 

made later with image-editing software. Infrared dust and scratch correction and grain reduction 

can be applied during scanning. 

Raw Output. With the professional version of VueScan, the raw image from the scanner 

can be output without application of a color profile for the scanner and without conversion to a 

working color space. Image-editing software would be used to apply a scanner profile and to 

convert the image to a working color space as well as to make all needed adjustments to tone 

and color. The infrared channel data can be saved as a separate channel in the raw file but can 

only be applied by VueScan and is not appropriate for a non-proprietary archival image. Infrared 

dust and scratch correction can be applied to the raw image before it is saved if certain settings 

are used. 

Output> Raw file: is a checkbox that will create a raw output file when checked. The raw file is 

made without applying a scanner profile or conversion to a working color space.  

Output> Raw file name: is a field to specify the name of the output file. The name can also be 

specified in the usual output file dialog box that will come up if this field is not changed. The 

file is in TIFF format by default, which is appropriate for archival scanning. 

Output> Raw file type: is a pick-list that specifies the color mode and bit depth for the output file. 

This normally will be set to “16 bit Gray” or “48 bit RG.” Selecting “Auto” or “64 bit RGBI” 

will include the infrared channel if the scanner has the capability for infrared dust and 

scratch correction. For archival scanning this infrared channel should not be included in the 

main master image.  

Output> Raw output with: should normally be set to either “Scan” or “Saved.” “Scan” indicates 

that the raw output file is created when the Scan button is clicked. “Saved” indicates that the 

raw output file is created when the usual output file is written or saved. With the “Saved” 

setting infrared dust and scratch correction and grain reduction will be applied to the output 

file if they are turned on, but tone and color adjustments are not applied.  

Output> Raw save film: is a checkbox that will include in the output file adjustments for the film 

settings under the color tab. In addition, infrared dust and scratch correction and grain 

reduction are applied if those were specified. Other tone and color adjustments are not 

included in the raw output file. This setting also writes the raw file when the image is saved, 

as occurs when Output> Raw output with: is set to “Saved,” and does this even if the setting 
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says “Scan” in the VueScan display. This can be somewhat confusing until a standard 

workflow is developed. 

Output> Raw compression: is a checkbox that determines whether the output raw file is 

compressed. The safest practice is to set this to “Off,” although “Auto” can be used if storage 

space is limited.  

The raw files created with 16 bits per channel have a gamma of 1.0, which makes a dark 

image that must be corrected with image editing. On the other hand, raw files created with 8 bits 

per channel have a gamma of 2.2, which is a more normal brightness.  

Condition 2. Scan Adjusted for Fading and Exposure 

An output histogram of the image after adjustments have been applied can be displayed by 

tapping Ctrl-4. The black end of the histogram is on the left and white end on the right. Ctrl-1 

displays a histogram of the raw scanned image before any adjustments. Ctrl-2 displays the input 

histogram that shows the black and white points with small triangles that can be dragged to 

adjust the black and white points. Ctrl-0 removes any graph that is being displayed. 

Set the Black and White Points. The black and white points on the histogram can be set 

with three fields under the Color tab. The histogram sliders displayed with Ctrl-2 can also be 

used. The histogram adjustments for the black and white points are done automatically in 

VueScan when the three fields are set. Unlike most other scanning software, there is no button to 

apply the black and white points. The black and white points and related adjustments 

automatically change if the cropping area selected for scanning is changed. 

Color> Color balance: determines whether and how the black and white points are applied to the 

histogram. “White balance” is the usual default and starting point. This adjusts the histogram 

to set the black and white points for each color channel individually and also automatically 

finds and adjusts colors for a gray area to remove color casts. “Neutral” is another frequently 

used setting that adjusts the histogram to set the black and white points for overall tone, but 

does not adjust the individual color channels or remove color casts. “Neutral” is used when 

the image has an overall color cast, such as a sunset or document with limited colors. 

“Manual” is another useful setting that is described later for the gray eyedropper. There are 

other possible settings for color balance that are obvious from their names and may be useful 

in certain situations. 

Color> Black point (%): determines the percent of the darkest pixels that are set to black or 

clipped. The usual default for archival images is zero which assures that no useful pixels are 

clipped by default. As described in Chapter 3, the histogram for photographs usually should 

nearly cover the full range of tone and the histogram for faded historical photographs needs 
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to be expanded. The output histogram after adjustments have been applied can be viewed by 

tapping Ctrl-4.  

Color> White point (%): determines the percent of the lightest pixels that are set to white and is 

usually zero for archival scanning. The principles described above for the black point also 

apply to the white point that is at the right or light end of the histogram. 

Note that the VueScan controls for black and white points focus on the percent of pixels that 

are clipped rather than on tones on the histogram axis as in other scanning software. The percent 

of pixels clipped provides a much greater awareness of the degree of clipping that is occurring. 

Any value above zero will result is some clipped pixels.  

Minimize Distortion. As described in Chapter 3, borders, dust, and damage in an image 

sometimes interfere with setting the black and white points. The number of these outlying pixels 

may be too small to show up vertically in the histogram, but the histogram does not cover the 

full range of tones as expected. The lightest or darkest pixels are often far from the main body of 

the histogram and need to be clipped to expand the histogram. VueScan has several features that 

are very useful for appropriately controlling clipping.  

Infrared dust and scratch correction is applied before the tone and color adjustments are 

made. This minimizes distortion from defects.  

The VueScan feature to display clipped pixels (Color> Pixel Color:) is very useful in verifying 

that only insignificant spots are clipped. As the percent of clipped pixels for the black and white 

points are increased the clipped pixels are displayed. Entering a value of .001 for the percent 

clipped pixels is often a good starting point for expanding the histogram. The values for percent 

clipped pixels can also be changed by clicking the small up and down arrows to the right of the 

field. The optimal values can be determined by viewing both the output histogram and clipped 

pixels while adjusting the black point percent. As noted in Chapter 3 the best practice is to have 

the extreme right and left edges of the main body of the output histogram be set in slightly from 

the ends of the histogram horizontal axis. 

VueScan also has an option to minimize distortions from borders by slightly reducing the 

area that is used in determining the black and white points.  

Crop> Buffer(%): specifies a percent of the cropped area selected for scanning that is excluded 

when determining the values for adjusting color. The reduced area minimizes distortions 

from borders or damage on the edges of the source item when making adjustments and has 

little or no impact when there are no borders or edge damage. Once the adjustments are 

determined, they are applied to the full area selected for the scan. The value for this option is 

a percent of the size of the cropped area. The default setting of 5% is reasonable for most 

cases and can be increased if borders or edge damage are of concern on an item. The crop 
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buffer area is excluded from the histogram display, but clipped pixels in the crop buffer area 

are indicated. 

 
Set Output Tones for Black and White. VueScan does not have controls to precisely set 

numeric values for the darkest and lightest tones in the output image. As discussed in Chapters 2 

and 3, it is good practice to make the darkest and lightest tones in the output image not be pure 

black and pure white.  

One useful strategy with VueScan is to find the black and white point settings that just begin 

to clip useful pixels in the image and then back off from those settings to a degree that provides a 

margin from pure black and pure white. Also, the outer edges of the output histogram (Ctrl-4) 

should not extend to the very ends of the histogram horizontal axis. These methods are adequate 

for good practices as described in Chapters 2 and 3.  

Consistent with the general philosophy of VueScan, subsequent processing with an image 

editing program will be needed for the more precise control for best practices. VueScan can be 

used to assure that unwanted clipping does not occur, but precise adjustments are done with 

image-editing software. 

Adjust the Mid-Tone Slider if Needed. Color> Brightness: adjusts the mid-tones or 

gamma in the same way that the usual mid-tone slider operates on a histogram. As usual with 

VueScan tone and color adjustments the value can be changed by clicking the up and down 

arrows or by directly entering a value. 

Gray Eyedropper and Color Adjustments. VueScan has a gray eyedropper function 

but it operates differently than for most image-processing software. A gray eyedropper is 

implemented in VueScan by placing the tip of the mouse pointer over a spot in the image that 

should be white or very light gray and right-clicking the mouse. This adjusts the colors to make 

the spot have equal amounts of red, green, and blue with the same overall tone and without 

changing the black and white points. When the right mouse button is clicked, certain settings 

automatically occur. The field Color> Color balance: is set to Manual and three additional fields 

are displayed: Color> Neutral red:, Color> Neutral green:, and Color> Neutral blue:. These 

additional fields can be manually adjusted but are not intuitive to use. Moving a slider to the left 

from the maximum position appears to increase the intensity of the specified color up to a point 

but then reduces the intensity of the other colors.  

My experience has been that the gray eyedropper function in VueScan does not correct color 

casts as well as most image-processing software. Experiments with photographs and with graded 

grayscale cards found that the gray eyedropper function is effective only if a white or very light 

gray spot is right-clicked. A medium gray spot results in significant color distortions.  Right-
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clicking a different spot changes the active adjustment point. Different spots can be explored 

until a good color adjustment is found.  

Color adjustments can also be manually made with the fields for Color> Brightness red:, 

Color> Brightness green:, and Color> Brightness blue:. These adjust the mid-tones for individual 

colors in the same way that mid-tone sliders on a histogram operate with individual color 

channels. The greatest effect for these fields is on the left or dark end of the histogram. Color 

adjustments can be made by carefully observing the image and the output histogram as these 

fields are changed. However, final refinement of color adjustments can often be done more easily 

and precisely with image-editing software. 

Filter> Restore colors: and Filter> Restore fading: may usefully improve colors in some cases, 

but in my experience they are not useful in the majority of cases.  

Adjust Contrast. Ctrl-3 displays a curve that shows the mapping of input tone on the 

horizontal axis to output tone on the vertical axis. The curve can be adjusted by dragging two 

small triangle sliders under the graph to increase or decrease shadows and highlight or, 

equivalently, by adjusting two fields.  

Color> Curve low: is used to adjust the dark areas in the image to increase or decrease contrast. 

Increasing this setting makes the dark areas darker, which increases contrast. Increasing the 

value from the default of .25 to .30 often enhances faded historical images. Reducing the 

value reduces contrast in the image, which can also be useful in certain situations. 

Color> Curve high: is used to adjust the light areas in the image to increase or decrease contrast. 

Decreasing this setting makes the light areas lighter, which increases contrast. Decreasing the 

value from the default of .75 to .70 often enhances faded historical images. Increasing the 

value reduces contrast in the image, which can also be useful in certain situations. 

Scanning Documents. VueScan and other scanning software do not have built-in settings 

for scanning off-white or cream-colored paper that is common with historical documents. These 

documents tend to become darker and more yellow or brown with age. Setting Color> Color 

balance: to “White balance” tends to produce results that are too white, and setting it to 

“Neutral” produces results that are too yellow or brown. After various experiments I have found 

the following settings to be a useful starting point in working with documents that were 

originally off-white or cream-colored. The settings may need to be modified for best results with 

different scanners. 

Color> Color balance: White balance 

Color> Black point (%): 0 

Color> White point (%): 0 

Color> Curve low: 0.4 

Color> Curve high: 0.65 
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Color> Brightness: 1.06 

Color> Brightness red: 0.85 

Color> Brightness green: 1 

Color> Brightness blue: 0.80 

These are useful as saved settings and can be adapted for an individual document. To further 

lighten the paper color, increase Color> White point (%): and/or Color> Brightness:. To reduce 

or increase the amount of yellow color, increase or decrease the value for Color> Brightness 

blue:. The setting for Color> Brightness red: may also need adjustment. To make the writing in 

the document darker, increase Color> Black point (%): and/or reduce Color> Brightness:. A low 

value such as .001 may be needed for Color> Black point (%): to minimize changes to the paper 

color.   

When the original document had a significantly yellowish or brownish color, the following 

settings are often a good starting point. 

Color> Color balance: Neutral 

Color> Black point (%): 0 

Color> White point (%): 0 

Color> Curve low: 0.4 

Color> Curve high: 0.65 

Color> Brightness: 1.18 

Color> Brightness red: 0.775 

Color> Brightness green: 1.12 

Color> Brightness blue: 0.90 

Adaptations for individual documents can be made as described above. 

As described above, an efficient workflow for scanning simple documents such as letters is to 

set the preview scan resolution to the final desired resolution. After doing the preview scan, set 

the cropping and color adjustments and then save the output image without doing a separate 

step of performing a high-resolution scan. Multiple pages or items can be included in the preview 

scan and cropping, color adjustments, rotation, and saving done separately for each page or item 

without repeating the preview scan. The Scan tab can be clicked to view the enlarged cropped 

image to verify cropping or adjust tone and color. 

As noted earlier, the setting for Input> Media size: may need to be set to “Maximum” if the 

full scanning bed is to be used with items larger than 8.5 x 11 inches. 

Condition 3. Scan Adjusted for a Reference Target 

Tone and color adjustments for images with reference targets included are most efficiently 

done with image-editing software because VueScan does not have the needed black and white 
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eyedropper tools. Setting black and white color patches on a reference target to certain tones 

would require trial and error adjustments in VueScan. When the mouse pointer is held over a 

spot on the image, the red, green, and blue numeric color values are displayed below the image 

on the right. The fields Color> Black point (%): and Color> White point (%): could be increased 

slowly and the color values checked for the black and white color patches until appropriate value 

were obtained. The options for lock image color described in the later section on additional 

information might also be needed. The gray eyedropper function described above could be used 

to remove color casts and Color> Brightness: could be used to set the numeric color values for 

the middle gray color patch on the reference target.  

With practice a person might get more efficient with this process, but I would expect the 

most efficient workflow would be to use image-editing software to adjust tone and color for a 

reference target. 

Set the Output File Name and Save the Image 

The image is saved to an output file when the Save or floppy disk icon under the image is 

clicked. A dialog box will pop up asking for the name and folder for the output file. Alternatively, 

Output> TIFF file name: can be used to set to the output file name. 

2.4 Scanning Multiple Frames 

VueScan can be set to scan multiple items when multiple items have been placed on the 

scanning bed. Typically this would be strips of negative film or multiple slides, but it can also 

include multiple photographs or documents placed on the scanning bed. The scanning mode, 

media, resolution, bit depth, brand and type of film, and output color space are the same for all 

the items scanned. The cropping, filters, color balance, black and white points, curves, and 

brightness can be set for each individual item. The actual time saved by scanning multiple items 

at once is usually minimal for historical items due to the time spent specifying settings for each 

item. However, time can be saved if the same settings are used for many items. 

Scanning multiple frames is initiated under the Crop tab. 

Crop> Multi crop: can be set to “Custom” to turn on multiple item scanning. The other options 

can be explored but “Custom” will likely be used most frequently. 

Crop> X images: specifies the number of items or images that occur horizontally. For example, 

enter 2 if there are two items across the scanning bed. Enter 1 if there is only one strip of 

film. 
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Crop> Y images: specifies the number of items or images that occur vertically. VueScan will make 

a separate image for each combination of the X and Y images.  

Crop> Show multi outline: is a checkbox that displays the grid defined by the X and Y images 

above. 

The grid outline is displayed on the Preview display. Clicking the mouse in a section of the 

Preview grid sets VueScan to apply settings to that particular grid section or frame. The frames 

are numbered and the number for the currently selected or active frame is shown on the left 

below the display image and also in the field Input> Frame number:. Another frame can be made 

active by clicking a different section of the grid in the Preview display, by clicking the right or left 

arrow on the right below the display, or by changing the frame number in the field Input> Frame 

number:. The grid determines the number of frames but the actual cropped area for a frame does 

not have to be completely within the selected grid outline. 

For the active frame, the usual methods can be used to set cropping, filters, and color 

adjustments. After the settings are complete for all frames, clicking the Scan button causes a 

separate image to be made for each frame. The images are displayed one at a time under the 

Scan tab on the display using the navigation methods described above. When the images are 

saved to a file, separate files are made for each image and the dialog box for file name comes up 

for each file. 

In my experience, the fields for X and Y spacing and X and Y linked under the Crop tab are 

not very useful and can be left alone. 

2.5 Color Management 

The professional version of VueScan includes options for assigning profiles for the working 

color space, monitor, and scanner. The standard version of VueScan does not have these options. 

The standard version uses sRGB as the working color space and also uses a generic sRGB profile 

for the monitor profile. The inability to use a more optimal profile for the monitor is a significant 

disadvantage for archival work with the standard version of VueScan.  

Using Profiles 

The professional version of VueScan can apply custom scanner profiles, but only profiles 

made with VueScan. If a scanner profile made with other software is assigned, the default Built-

in” profile that comes with VueScan is used and there is no warning message that the assigned 

profile is not used. Color management profiles are assigned under the Color tab in the 

professional version of VueScan. 
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Color> Output color space: sets the working color space for the output file. The options include 

“sRGB,” “Adobe RGB,” and “Gray,” which is Gray Gamma 2.2.  

Color> Monitor color space: can be set to “ICC Profile” for custom color profiles for the monitor. 

Color> Monitor ICC profile: specifies the file name and location for the monitor profile. This field 

appears if the monitor color space above is set to “ICC Profile.” VueScan requires that the file 

name for a custom profile be specified here and currently does not have an option to 

automatically determine the default profile specified by the operating system. Given the need 

to manually specify the file name for the profile, it is easiest and most reliable to have the 

current custom profile always have the same file name. The software making the monitor 

profile may give each updated version of the profile a different file name by default. If the 

profile name is changed, each set of saved options in VueScan must be updated. It is usually 

much easier to use a fixed file name for the current profile than to update all the saved 

settings in VueScan.  

Color> Scanner color space: can similarly be set to ICC Profile and the name of the file with the 

custom profile can be specified. The alternative is to use the “Built-in” profile that comes with 

VueScan. As noted above, only custom profiles made with VueScan are used. 

Color> Printer color space: can be set to ICC Profile and a profile specified. I have never tried to 

print from VueScan or work with this option. 

Making a Scanner Profile 

VueScan includes a simple process for making a custom scanner profile. An IT8 target needs 

to be obtained (see Appendix A). The instructions for making and using the profile are 

straightforward in the VueScan manual. It is best to give each profile a name that indicates the 

scanner and type of media (paper or slide). The scanner profiles can be kept in the folder for 

VueScan or put in the folder that has the profiles for the operating system (see Appendix A on 

color management). Note that the file specified in Color> Scanner IT8 data: is provided with the 

target and has the specific color data for the IT8 target. This file is used only when the scanner 

profile it created.  

VueScan creates matrix profiles for a scanner. The conversion to working color space will use 

the relative colorimetric rendering intent because both the scanner profile and working color 

space profile are matrix profiles. As discussed in Appendix A, conversions between matrix 

profiles use the relative colorimetric rendering intent.  
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Output Files 

Both the professional and standard versions of VueScan can embed the profile for the 

selected working color space in the output files; however, the standard version only has the sRGB 

as the working color space.  

Output> TIFF profile: and Output> JPEG profile: are checkboxes that determine whether the 

profile for the working color space is embedded in the output file.  

VueScan does not write EXIF fields to output files. 

Printer Profiles 

VueScan also includes a process for making custom printer profiles using a scanner that has 

been profiled. However, VueScan makes a simple matrix profile rather than a more detailed 

lookup table profile that is normally used for printers. As discussed in Appendix A, the perceptual 

rendering intent is not applicable with matrix profiles. Also, printer profiles developed with 

scanners are generally considered to be less accurate than profiles developed with the specialized 

equipment for making printer profiles. My one experience making a printer profile with VueScan 

produced a profile that I believe did not adequately represent the capabilities of the printer.  

2.6 Additional Information 

Skew or Slightly Rotating Images 

The option Input> Skew: can rotate an image up to five degrees and is intended to allow 

minor adjustment of the alignment of an item being scanned. The cropped rotated image is 

displayed under the Scan tab and the full image with cropping lines is displayed under the 

Preview tab. The rotation is done with image processing after the scanned image is made and 

can be modified without re-doing the scan.  

This Skew option is generally not optimal for archival scanning. As noted in Chapter 2, 

software rotation to odd angles (not 90 degrees) tends to soften images and loose find detail. 

The optimal practice is to place the item on the scanning bed so that slight rotation is not 

needed. My comparison of slight rotation with VueScan versus Photoshop found that Photoshop 

produced less softening of the image. However, the image without slight software rotation was 

best and is optimal for historical research that involves fine details.  
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VueScan from Photoshop 

VueScan can be run from within Photoshop CS or Photoshop Elements but working color 

space must be handled carefully. In Photoshop the dropdown menu File> Import> VueScan 

opens VueScan with its usual features. After a scanned image has been created, clicking the save 

icon in VueScan exports the image to Photoshop. However, the image apparently is exported to 

Photoshop in a way that bypasses the usual checking of working color space. The image is 

assigned the working color space that is the default in Photoshop even if that is not the output 

color space used in VueScan. The working color space in Photoshop is not converted and can 

have the usual problems from improperly handled color space. The problems can be avoided by 

making sure the output color space in VueScan matches the default working color space in 

Photoshop. If VueScan is run from within Photoshop, a fixed standard process would be valuable 

to minimize the risks of problems. 

Lock Image Color 

The option to Lock image color can be used to apply fixed color settings when several items 

will be scanned with the same settings. This saves time and also allows color settings that are not 

possible with the usual controls. It can also be useful in understanding how VueScan is setting 

the black and white points for the histogram.  

When the Input> Lock image color: checkbox is checked, the color settings that were used on 

the last preview or high-resolution scan are locked and used for scanning other items. In 

addition, the Color tab has items that display and can set the black and white points individually 

for each color channel, and the histogram display (Ctrl-2) has sliders that display and can set the 

black and white points for each color channel. These displays can be useful in understanding 

how the black and white points are being set with the different color settings. For example, 

Color> Color balance: could be set to “White balance.” Then setting Input> Lock image color: will 

display the black and white points for the individual color channels for the Color Balance and 

other black and white point settings that are being applied. 

Note that a new preview or high-resolution scan is needed if the color settings are changed 

after an initial preview scan. For example, if the Color> Color balance: setting is changed, 

another preview or high-resolution scan must be done to have Input> Lock image color: display 

and use the revised settings. Once the image color has been locked, revisions using the special 

controls for each color channel are kept without needing another scan. 

The additional fields for setting black and white points for the individual color channels can 

be used to set the points outside the darkest and lightest tones in the image. That type of control 
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is not possible with the usual controls under the Color tab that set the black and white points at 

or inside the darkest and lightest tones in the image. However, the usual controls work well for 

most historical items. 

For reflective items such as paper photographs, Input> Lock image color: can be set directly. 

Slides or negatives require additional steps to lock the image color. First click the checkbox 

Input> Lock exposure:. This generates a new checkbox Input> Lock film base color:.  Clicking this 

checkbox generates a new checkbox Input> Lock image color:.  The options and steps may be 

slightly different with different scanners. Remember to uncheck all the locked checkboxes before 

scanning an item that will use different settings.  

Batch Processing 

VueScan has batch processing capabilities that may be useful when scanning many items 

with the same size, exposure, and location on the scanning bed. That degree of consistency is not 

common for historical scanning but could be useful in certain situations such as scanning 

documents with many similar pages. Instructions for batch scanning can be found in the VueScan 

manual. 

File Location 

With a Windows 7 operating system, the current versions of VueScan put the configuration, 

log, and profile files in the folder C:\Users\_username_\Pictures\VueScan by default, where 

_username_ is the login name for the user. Older versions of VueScan put these files in the folder 

c:\vuescan on the root of the computer hard drive.  
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